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1. Global Trade Management Overview

Overview

Global trade practice requires companies to have access to and use the current trade data available.
There are many types of trade data available with various sources, both nationally and internationally.
Failure to use the most up-to-date data can result in inaccurate screenings which may lead to
significant fines and penalties, delays, revocation of trade privileges, and lost revenues. Examples of
trade content include, but are not limited to:

e Denied Party Screening Lists

e Harmonized System and Classification Information
e Tariff and Duty Rates

e Binding Rules and Regulations

e Free Trade Agreement Information

Every company must abide by its government’s import/export policies. Global Trade Management
(GTM) assists companies by:

e Identifying business transactions which violate any law or lack the required licenses
e Classifying the goods using the Harmonized Commodity Description and Coding System
e Consolidating the transaction details required for Customs filing

Each business transaction involves many parties but the companies cannot do business with any party
that has been labeled by the governmental authority as a restricted party. The authorities publish the
list of restricted parties from time to time. GTM provides functionality to download this list from any
third party data content provider and perform screening of involved parties against the list of
‘Restricted’ parties identified by the government.

On similar lines, GTM helps users to download, update, or view product classification data and other
related compliance elements for prompt and accurate customs filing.

This document talks about the details and the format of the documents/data downloaded from the
content provider and the data mapping between the content provider and GTM.

Note: This document talks about the existing flow between GTM and a third party data content
provider.

Copyright © 2012, 2018 Oracle and/or its affiliates. All rights reserved. 7



2. GTM Services

Restricted Party Screening

The United States of America and other regional, unilateral, and multilateral agencies enforce
regulations which restrict businesses and people from conducting trade with specific foreign entities
(individuals, companies, countries). These entities are referred to as Denied, Debarred, and/or
Restricted Parties. Examples of these entities include but are not limited to known terrorists,
organizations that fund terrorists, and parties guilty of trade violations. Typically, the restricted parties
are mainly countries subject to embargoes, and persons, businesses, and organizations subject to
financial sanctions. Periodically, these agencies publish lists of entities that are marked as restricted
parties.

In order to adhere to the regulations, companies screen their party master data and transactions
against these lists, which can be very time consuming and laborious. Furthermore, if a business ships
goods to a restricted party, it could incur fines, penalties, and ultimately the loss of export privileges.

GTM provides functionality to download this list from any third party data content provider and
perform screening of involved parties against the list of ‘Restricted’ parties identified by the
government.

Product Classification

Some products (such as munitions and computer hardware for example) exported from the United
States require an export license from either the U.S. Department of Commerce or another U.S. agency
like the State Department. Before you can determine whether your product requires an export license,
you must first investigate if your product has an Export Control Classification Number (ECCN).

In addition, before you can export or import a product, you must first identify your product’s proper
Schedule B (for exports) or Harmonized Schedule (HS) (for imports) number. This number must
appear on both export and import documentation that accompanies a shipment.

The Harmonized Commodity Description and Coding System, also known as the Harmonized System
(HS) of tariff nomenclature is an internationally standardized system of nhames and numbers to classify
traded products. HS codes are used by customs authorities, statistical agencies, and other
government regulatory bodies, to monitor and control the import and export of commodities through:

e Customs tariffs

e Collection of international trade statistics

e Rules of origin

e Collection of internal taxes

e Trade negotiations (e.g., the World Trade Organization schedules of tariff concessions)
e Transport tariffs and statistics

e Monitoring of controlled goods (e.g., wastes, narcotics, chemical weapons, ozone layer
depleting substances, endangered species)

e Areas of customs controls and procedures, including risk assessment, information technology
and compliance.

Companies use HS codes to calculate the total landed cost of imported products and parts, and to
identify selling and sourcing opportunities abroad. GTM helps you to download, update, or view
product classification data and other related compliance elements for prompt and accurate customs
filing.
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Finally, some countries also provide munitions lists which may include services and technology that is
defense or space related. In some instances, customers may also need to assign munitions list
numbers to their items.

3. Download Process Flows of GTM

Government authorities publish and regularly update lists for compliance purposes. These lists include
the details of:

e Restricted parties
e Product classification codes for different product classification types
e Product classification code mappings from one type to another

GTM enables you to connect to any third party data provider and download the required data based on
specific configuration setup.

3-2 Copyright © 2012, 2018 Oracle and/or its affiliates. All rights reserved.
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3.1 - Flow of Data between GTM and the Data Content Provider
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4. Current Process in GTM

The following sections discuss the details of the functional flow between GTM and the data content
provider.

Connecting via Content Source

GTM allows you to bring in content from various external data sources. An external data source can be
modeled in GTM as a Content Source.

You can create custom Content Sources via Master Data > Power Data > Data Loading > Content
Source.

You must also configure what content should be downloaded in the Content Source Data Type section
on the Content Source power data window. The Source Data Type field contains the data type ID
provided by third party data provider. Data in the Content Type field identifies the type of content
(HTS-US, ML-US, RESTRICTED_PARTY, etc.) to be downloaded.

Note: The preferred approach is to have two different content sources per provider: one for
restricted party list screening data and one for classification data.

ORACLE"

Content Source 10f1 New Finished

* Content Source ID Source Name Domain Name
[CONTENT SOURCE CONTENT SOURCE FA B

4 Content Source Data Type

* Sequence * Source Data Type Source Country ID Content Type

suored
1 oPL & 7%
2 HSN JAY 7%
3 HSN Ay 7%
4 HSN JAY HTS-PH 77X

4 Configuration

Configuration Active Communication Method External System ID
GTM_CONFIG & HTTPPOST (CONTENT PROVIDER 7%

New Content Source Config

4.1 - Content Source
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The external system identifies the site from where the data content will be downloaded and the
communication method indicates how it should be downloaded. On this page, you must provide the
details for both the external system location and the communication method as *HTTPPOST".

Note: The external system must be specified on the Content Source page configured above.

You can refer to the Customs Filing Integration Guide for more details on communication method.

ORACLE’ F

External System Previous 2 of 2 New Finished
* External System ID Description Integration Preference ID Use Credential Include Namespace
CONTENT PROVIDEF O\ 65 a DEFAULT B

User Name Password Password (Confirm)
GTMUser cosssees cssecsses|
Target Namespace

http:/ixmins.oracle.com/apps/otmAtransmissionie.4 B

Active Mode Enable Debug Log Response
Enabled B o o

Reattempt Mode Max Reattempts Transport Through Data Stream
@

None - ERROR Status B

Max Bytes Per Trans. Max Transactions Per Trans. Socket Timeout

4 For HTTP/HTTPS

URL
https://company.com/status/statusdocument.xmi

Read Response Code Trans Acknowledgement Expected Use Acknowledgement Status
£
Close HTTP Connection HTTP Profile ID Acknowledgement Stylesheet Profile ID
] 055 055
\ \
4 ForFTP
Hostname Port Remote Directory Connection Mode Use FTP Append Use Secure FTP
a o

4.2 - External system

Downloading the Status Document

When you perform the Download Data Content action and provide a content source, GTM logs onto the
external system via the URL specified and downloads an XML file known as a status document.

The XML file downloaded from the third party data provider specifies:

e All of the available data types
e The dates when they were last updated
e A download link

Based on the information contained in the status document and the data types specified for download
in the content source, GTM parses the status document and downloads any new content available.

Sample Status Document

<?xml version="1.0" encoding="us-ascii"?>
<Status Document xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<Version ID>39</Version ID>
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<Last Update DT>10/14/2010</Last Update DT>
<File Detail>
<Files>
<File ID>12</File ID>
<Update Indicator>0</Update Indicator>
<Data Type>HSN</Data Type>
<Country>mx</Country>
<Description>Tariff Data, specifically HS Codes and Descriptions.
Contains HSMaster and HSParts tables.</Description>
<URL>https:/company.com/SampleData/mx ** 20080918.zip</URL>
</Files>
<Files>
<File ID>78</File ID>
<Update Indicator>1</Update Indicator>
<Data Type>DPL</Data Type>
<Country>us</Country>
<Description>Master DPL</Description>
<URL>https:/company.com/SampleData/dpl ** 20100819.zip</URL>
</Files>
<Files>
<File ID>97</File ID>
<Data File>DPL</Data File>
<Update Indicator>1</Update Indicator>
<Requires File ID>96</Requires File ID>
<Data Type>DPL</Data Type>
<Country>us</Country>
<Publish DT>10/01/2010</Publish DT>
<Description>Delta DPL</Description>
<URL>https:/company.com/SampleData/dpl ** 20101001 16 20.zip</URL>
</Files>
<Files>
<File ID>5035</File_ID>
<Data File>Eccn-Descriptions-HK-EN</Data File>
<Update Indicator>0</Update Indicator>
<Requires File ID>0</Requires File ID>
<Data Type>ECCN</Data Type>
<Country>HK</Country>
<Publish DT>04/15/2014</Publish DT>
<Description>ECCN text broken down by paragraphs</Description>
<URL>https://company.com/SampleData/ECCN ** en 20140418 09 04.zip</URL>
<Language Cd>EN</Language Cd>
</Files>
<Files>
<File ID>12860</File ID>
<Data File>ScheduleBNomenclature</Data File>
<Update Indicator>0</Update Indicator>
<Requires File ID>0</Requires File ID>
<Data_ Type>SCHEDB</Data Type>
<Country>US</Country>
<Publish DT>01/24/2017</Publish DT>
<Description>Schedule B Nomenclature. Contains HSMaster and HSParts
tables.</Description>
<URL>https://company.com.com/SampleData/schedb en 20170128 12 19.zip</URL>
<Language Cd>EN</Language Cd>
</Files>
<Files>
<File ID>14906</File ID>
<Data File>mlNomenclature</Data File>
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<Update Indicator>0</Update Indicator>
<Requires File ID>0</Requires File ID>
<Data Type>HSN</Data Type>
<Country>ML</Country>
<Publish DT>03/14/2014</Publish DT>
<Description>Munition Lists</Description>
<URL>https://company.com.com/SampleData/ml ** en 20140314 14 30.zip</URL>
<Language Cd>EN</Language Cd>
</Files>
</File Detail>
</Status_Document>

Consider the above sample status XML file snippet provided by the third party content provider. There
are a couple of key attributes that should be noted:

e Version_ID: GTM uses this element to check whether the status document has been
previously downloaded or processed.

e File_ID: The content provider can push changes to data content in file format. This ID is
unique and is tied to a corresponding data zip file. It is never re-used in any further
downloads.

e Update_Indicator: This tells you if the zip file is a master data list or an incremental update
list. If the indicator is 0, it is a master data list; if 1, then it is an update/delta list.

¢ Requires_File_ID: This can be used to indicate the dependency between the files. For denied
party data, this identifies the data file (master or delta) which should be processed before the
current data file (delta). For classification data, this identifies the data content file in which the
details are present with the English language. Content providers need to always provide the
Required_File ID (the file with English language records) for other languages.

e Country: The 2-digit country code for which this zip file data applies.
e URL: URL for the zip files to download.

The third party content provider should start by publishing a status document with only master data.
There should be one master file, which is the consolidated list of all denied parties. When new entries
need to be added, they should be created as delta files. All the master data files should have an
Update_Indicator of “0”. All the delta data files should have an Update_Indicator of *1” and
appropriate File_ID and Version_ID in the status document.

There is no delta file concept related to product classification data as GTM downloads the complete list
of product classification codes every time. The Update_Indicator should always be 0 in case of product
classification code data.

Processing of the Status Document

GTM processes the status document as follows:

e Looks at the Version_ID.

e Reads each File_ID and checks if they are processed.

e If the File_ID has been processed, there is nothing else for GTM to do.

e If the File_ID has not been processed, GTM downloads the zip file and loads the content.

Data Version
A data version is a set of data to be considered for any GTM service, such as denied party screening or

product classification. A data version is composed of two attributes, the type of data
(DPL/HSN/ECCN/Schedule-B), and the country to which it applies. Therefore, there is one data version

4-4 Copyright © 2012, 2018 Oracle and/or its affiliates. All rights reserved.



for US/DPL data, one version for US/HSN data, one version for MX/HSN data and so on. Ideally, there
is one data version marked as current for type of data and country combination.

GTM loads the content as follows:

e If the update indicator is 1, then GTM will look up the current data version for that particular

data type and country. A new data version (GTM_DATA_VERSION_GID) is not created and
updates are made to the existing data version. These updates are referred to as a delta list
and is typically seen when a client downloads restricted party data.

e If the update indicator is 0, then this is a master data file. Typically this is seen when a client

first downloads the data or if the data is classification code data.

o When the indicator is 0, GTM will create a new data version for this data type and
country combination. Therefore, it is possible that there will be multiple data versions
for classification data such as HSN, ECCN, ML and Schedule B. GTM will then set this
new data version as current, and set all other existing data versions that apply for this
data type and country to be not current.

Downloading the Zip Files

Based on the URLs provided in the status document, GTM downloads the zipped folders. The zipped
folders should contain the following files with raw data provided by content provider:

MASTER: This must be present in the zipped folder for all the classification download with raw data
provided by content provider. The file name must contain the word *MASTER'. This file will contain
the details of classification code.

PARTS: This must be present in the zipped folder for all the classification download with raw data
provided by content provider. The file name must contain the word ‘PARTS’. This will contain the
parent classification of any classification code.

UOM: This file should be present for HTS, HSN-EX, Schedule B download. The file hame must
contain the word ‘UOM’. This will contain the UOM details classification of any classification code.

ATTRIBUTES: This file should be present for HTS, HSN-EX, Schedule B, ECCN, and ML download.
The file name must contain the word ‘ATTRIBUTES’. This will contain the parent classification of
any classification code.

SOURCE: The zipped folders for restricted party must contain a single file with *'SOURCE’ word in
the file name. This file will contain details of all the restricted parties.

Sample Raw HSN Data from the Downloaded Files

mstr id| |hscode| |language id| |country id]||full desc]| |part id]||iso_language]| |iso
_country||data typel| |uoml| |uom2]| |sitc| |enduse cd||asusda flag||naics]| |hitech] |e
ff beg dt||eff end dt||uom3||ogall||oga2||oga3|loga4d||add flag]||cvd flagl||quota
ind| |short desc| |AES Export Allowed| |LACEY

6624943110101210000 [1128]1502] |Live animals: Live horses, asses, mules, and
hinnies: Horses: Purebred breeding

animals| 61180098 |EN| |US| |SchedB]| INOJ| || |00150]10140110]11129201]00|]1/1/2012

12:00:00 AM| 12/31/9999 12:00:00 AM| |11l 1IIIl]]]||HORSES, PUREBRED BREEDING,
LIVE|| ]
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6624944110101290000 [ 1128 502] |Live animals: Live horses, asses, mules, and
hinnies: Horses:
Other| 61180099 |EN| |US| |SchedB| [NO| || 00150 110140|10]1112920]100]11/1/2012

12:00:00 AM| |12/31/9999 12:00:00 AM| ||| 111111l ]]|]HORSES, LIVE, EXCEPT
PUREBRED BREEDING] || |

6624945|110101300000 [ 1128502 |Live animals: Live horses, asses, mules, and
hinnies:

Asses| 61180100 |[EN| |US||SchedB]| |[NO||||00150]110140]10]|112920|00|11/1/2012
12:00:00 AM| |12/31/9999 12:00:00 AM| [ [ || IIIIIIIIIII||ASSES, LIVE]| |||
6624946|10101900000 [ 1128 502] |Live animals: Live horses, asses, mules, and
hinnies:

Other| 61180101 |EN| |US| |SchedB| |NO| || |00150|110140|10]1112920]100]11/1/2012
12:00:00 AM| |12/31/9999 12:00:00 AM| ||| 1 11111 II]]|||MULES AND HINNIES,

LIVE]| |||

6624947110102210010 [ 11281502 |Live animals: Live bovine animals: Cattle:

Purebred breeding animals: Dairy:
Male| |61180106| |EN||US||SchedB||NO||||00111]]10140]|0]|11211X||00||1/1/2012

12:00:00 AM| |12/31/9999 12:00:00 AM| |||l IIIIIll]l||BOVINES, PUREBRED
BREEDING, DAIRY, MALE, LIVE]| |||
6624948110102210020 [ 11281502 |Live animals: Live bovine animals: Cattle:

Purebred breeding animals: Dairy:

Female|| 61180107 | |EN| |US||SchedB| |NO|||]00111||10140]|0]]11211X|]00]]|1/1/2012
12:00:00 AM| [12/31/9999 12:00:00 2M| [ |1 III1I1111I11]]|IBOVINES, PUREBRED
BREEDING, DAIRY, FEMALE, LI| |||

Sample Raw ECCN Data from the Downloaded Files

mstr id||eccn nol|eccn desc||part id||iso language| |beg eff dt||last update dt|
lend eff dt||iso _country| |unit]||notes||AT||AT1||AT2||CB||CB1||CB2||CB3||CC]||CCl
| |ICC2| |C3||CW| |EI||FC1]||MT1||MT2]||NP||NP1||NP2||NS1||NS2]||RS||RS1]||RS2||SI||SL]|
|SS| |UN| |Z]| |AGR| |APP| |APR| |AVS| |BAG]| |CIV| |ENC]| |GBS| |GFT]||GOV| |KMI| |LVS| |RPL]||ST
A||TMP| |TSR| | TSU

EU ECCN 0] 10 | ICATEGORY 0 NUCLEAR MATERIALS, FACILITIES, AND
EQUIPMENT| |[EU ECCN O |EN|[1980-01-01]]2016-07-20]12050-01-01] |EU| |||
Frrrrrrerrrrerrrrrreerrrrrerrrrrrrerrrrrrr et et r e e e
FEETEEEEErrrn

EU ECCN _OA||0A | |CATEGORY 0 NUCLEAR MATERIALS, FACILITIES, AND
EQUIPMENT&#10; Systems, Equipment and Components||EU ECCN OA| |EN]||1980-01-
01112016-07-20112050-01-01| |EU| |||

Frrrrrrerrrrerrrrrreerrrrrerrrrrrr e e rr et et et et
FEETEEEEErrrn

EU _ECCN _0A001]|0A0O01 | |CATEGORY O NUCLEAR MATERIALS, FACILITIES,
AND EQUIPMENT&#10; Systems, Equipment and Components&#10; "Nuclear reactors”
and specially designed or prepared equipment and components therefor, as
follows: | |EU_ECCN OAQ0O01]| |EN]| [1980-01-01][2016-07-20]12050-01-01||EU]| |||
Frrrrererrrrrrrerrreerrrrrerrrrrrrrrrrrr et e et e et e
FEETEEEEErrrn

EU ECCN _OA0O01A||OAOOl.a | |CATEGORY 0 NUCLEAR MATERIALS, FACILITIES,
AND EQUIPMENT&#10; Systems, Equipment and Components&#10; "Nuclear reactors”
and specially designed or prepared equipment and components therefor, as
follows:&#10; a. "Nuclear reactors”;||EU ECCN OAOOlA||EN|[1980-01-01]2016-07-
20112050-01-01 | |EU|| ||
Frrrrrrerrrrrrrrrrrrerrrrrerrrrrrr e et et r ettt e e
FEETEEEEErrrn
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EU ECCN _0OA001B||0AOO0l.Db | |CATEGORY 0 NUCLEAR MATERIALS, FACILITIES,
AND EQUIPMENT&#10; Systems, Equipment and Componentsé&#10; "Nuclear reactors”
and specially designed or prepared equipment and components therefor, as
follows:&#10; b. Metal vessels, or major shop-fabricated parts therefor,
including the reactor vessel head for a reactor pressure vessel, specially
designed or prepared to contain the core of a "nuclear

reactor”; | |[EU_ECCN OAOO1B| |EN]| [1980-01-01|]2016-07-20]]12050-01-01]| |EU|
CErrrrrerrrrrrrrrerrerrrrerrerrerrrerr ettt et ettt e rrrrrrl
FITEETEErr e

EU ECCN_0OA001C||0AOOl.c | |CATEGORY 0 NUCLEAR MATERIALS, FACILITIES,
AND EQUIPMENT&#10; Systems, Equipment and Components&#10; "Nuclear reactors”
and specially designed or prepared equipment and components therefor, as
follows:&#10; c. Manipulative equipment specially designed or prepared for
inserting or removing fuel in a "nuclear reactor”;||EU ECCN_0AQO1C| |EN| [1980-
01-01112016-07-20]12050-01-01] |EU] || |

FErrrrrerrerrerreerrerrrrrrerrrerr e ettt et et e ettt et e e e
FITEETEErr e

EU ECCN 0OA001D||0AOO01.d | |CATEGORY 0 NUCLEAR MATERIALS, FACILITIES,
AND EQUIPMENT&#10; Systems, Equipment and Components&#10; "Nuclear reactors”
and specially designed or prepared equipment and components therefor, as
follows:&#10; d. Control rods specially designed or prepared for the control of
the fission process in a '"nuclear reactor”,support or suspension structures
therefore, rod drive mechanisms and rod guide tubes;||EU ECCN OAOOLD| |EN]| [1980-
01-01112016-07-201]12050-01-01] |EU] || |

FErrrrrerrerrerreerrerrrrrrerrrerrerrr ettt et et e ettt et e e e
FITEETEErrrrnd

Sample Raw ML Data from the Downloaded Files

Country cd||Language Cd]| |ID| |ml code||sme ind||ml _desc]| |note| |notel||note2]| |note3||not
e4||note5| |noteb

US| |EN||US MILIST O01||01||N||Category I-Firearms, Close Assault Weapons and Combat
Shotguns| | This coverage by the U.S. Munitions List in paragraphs (a) through (i) of
this category excludes any non-combat shotgun with a barrel length of 18 inches or
longer, BB, pellet, and muzzle loading (black powder) firearms. This category does not
cover riflescopes and sighting devices that are not manufactured to military
specifications. It also excludes accessories and attachments (e.g., belts, slings,
after market rubber grips, cleaning kits) for firearms that do not enhance the
usefulness, effectiveness, or capabilities of the firearm, components and parts. The
Department of Commerce regulates the export of such items. See the Export
Administration Regulations (15 CFR parts 730-799). In addition, license exemptions for
the items in this category are available in various parts of this subchapter (e.g.
§§123.17, 123.18 and 125.4) . [ [ [ ILITIIIIT1]

US| |EN||US MILIST OlA||Ol.al|Y||Category I-Firearms, Close Assault Weapons and Combat
Shotguns &#10; *(a) Nonautomatic and semi-automatic firearms to caliber .50 inclusive
(2.7 mm) LT

US| |EN||US MILIST O01B||0l.b||Y||Category I-Firearms, Close Assault Weapons and Combat
Shotguns &#10; *(b) Fully automatic firearms to .50 caliber inclusive (12.7
m) PP

US| |EN| |US MILIST 01C||0l.c||Y||Category I-Firearms, Close Assault Weapons and Combat
Shotguns &#10; *(c) Firearms or other weapons (e.g. insurgency-counterinsurgency,
close assault weapons systems) having a special military application regardless of
caliber. [ [ [II1IIITTITTT]
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US| |EN||US MILIST 01D||01.d||Y]||Category I-Firearms, Close Assault Weapons and Combat
Shotguns &#10; *(d) Combat shotguns. This includes any shotgun with a barrel length
less than 18 inches. ||| III111111]]

US| |EN||US MILIST O1E||0l.el||N
|

Category I-Firearms, Close Assault Weapons and Combat
Shotguns &#10; [Reserved] ||| | LTI

\
[ [

US| |EN| |US MILIST O1F||01.f||N||Category I-Firearms, Close Assault Weapons and Combat
Shotguns &#10; (f) Riflescopes manufactured to military specifications (See category
XII(c) for controls on night sighting devices.) |11 IIIIII1]]]

US| |EN| |US MILIST 01G||0l.g||Y||Category I-Firearms, Close Assault Weapons and Combat
Shotguns &#10; *(g) Barrels, cylinders, receivers (frames) or complete breech
mechanisms for the articles in paragraphs (a) through (d) of this
category. [ [ IIIITTTITTIT]

Sample Raw DPL Data from the Downloaded Files

ID| |FirstName| | LastName| |CompanyName | | Address| |City||State| |CountryCode| |Countr
yName | | ZipCode | | StartDate| |EndDate| |Fieldl | |Code| |LastUpdated]| | IDNUM| |[Voll| | Pag
el | |FedDatel| |Vol2||Page2]| |FedDate2| |Vol3| |Page3| |FedDate3| |Vol4d| |Paged | |FedDat
ed | |Vol5| |Page5| |FedDate5| |Volo6| |Page6 | |FedDateb6| |Vol7| |Page7| | FedDate7 | |Vol8]| |
Page8| |FedDate8| |Notes| |url

1241671 | |ANCIZAR| |ANDRADE QUINTERO| ||| ||CALI||]||CO]| |Colombial|]]|1996-03-
05112015-04-28||||sdnt||2015-04-28115311||61119524|11996-03-
O8Ittt ettt thttps://www.mkdenial.com/view. c
fm?idnum=5311] |

1241672 || || |J. FREDDY MAFLA Y CIA. S.C.S.||Carrera 4 No. 11-45 Ofc.

503| |CALI| || |CO| |Colombial || ]2003-03-27]|2015-04-28]|]||sdnt||2015-04-

28 11132820 (LTI Err ettt ettt et ettt e INIT # 800020482-

4| |https://www.mkdenial.com/view.cfm?idnum=13282] |

1241673| |JOSE FREDDY| |[MAFLA POLO| || |Carrera 4 No. 11-45 Ofc.

503| |CALI| || |CO]| |Colombial|]]2003-03-27]12015-04-28||]|sdnt||2015-04-

28 [ 1I33T720 Lttt ettt ettt thttps: //www.mkdeni
al.com/view.cfm?idnum=13372] |

1241674 | |JOSE FREDDY| |[MAFLA POLO]| || |Calle 52N No. 5B-

111 |CALI| || |CO| |Colombial|]]2003-03-27]|2015-04-28]|]||sdnt]||2015-04-

28 13373ttt Ihttps: //www.mkdeni
al.com/view.cfm?idnum=13373] |

1241675 |JOSE FREDDY| |[MAFLA POLO| || |Carrera 11 No. 46- 24 apt.

201 |CALI||||CO||Colombial || |2003-03-27|12015-04-28]]|]|sdnt]|2015-04-

28 13374ttt Ihttps: //www.mkdeni
al.com/view.cfm?idnum=13374] |

1241676| | JOSE FREDDY| |[MAFLA POLO| || |Carrera 11 No. 46-

26| |CALI||||CO||Colombial||]2003-03-27|12015-04-28]]]||sdnt]| |2015-04~-

28 [ 13375ttt Ihttps: //www.mkdeni
al.com/view.cfm?idnum=13375] |

1241677| |JOSE FREDDY| |[MAFLA POLO| | ||| |CALI||||CO||Colombial ]| |2003-03-27]]12015-
04-28|1]]|sdnt]| 2015-04-

28 113376 LIttt le/o COMPANIA DE
FOMENTO MERCANTIL S.A.||https://www.mkdenial.com/view.cfm?idnum=13376|
1241678| | JOSE FREDDY| |[MAFLA POLO| | ||| |PUERTO TEJADA||||CO||Colombial|]|]|2003-03-
27112015-04-28] ]| |sdnt]|2015-04-

28 13377 Lttt le/o CONSTRUCCIONES

PROGRESO DEL PUERTO S.A., | |https://www.mkdenial.com/view.cfm?idnum=13377] |
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Preparing GTM-Compatible CSVs

GTM cannot process the downloaded files directly since they do not contain GTM columns like gid/xid,
domain_name, insert_date, update_date, etc. The data load process parses these files and creates
GTM-specific CSV files that are formatted to load data directly into GTM tables.

The following sections provide the data mapping between the expected data provided by the content

provider and GTM.

Restricted Party Mapping

The restricted party data is saved in GTM_DENIED_PARTY table. The following table gives the data
saved to the GTM_DENIED_PARTY table.

Content GTM Element Description

Provider

Element

IDNUM GTM_DENIED_PARTY_GID Denied Party ID is a concatenation of
‘Data_Version_ ID'+_+'IDNum’.

GTM_DENIED_PARTY_XID

This is the only mandatory element to
create denied party data in GTM.
Eg: If the new data version ID is 12332 and
IDnum is 3242, the denied party ID would
be 12332_3242

FirstName FIRST_NAME First Name of the denied party

LastName LAST_NAME Last Name of the denied party

CompanyName COMPANY_NAME Company Name of the denied party

Address ADDRESS_LINE_1 Address of the denied party

City CITY City

State PROVINCE State/Province

CountryName COUNTRY Country Name

CountryCode COUNTRY_CODE Country Code
Eg: USA, IND

ZipCode POSTAL_CODE Postal Code

StartDate EFFECTIVE_DATE Effective Date of denied party

EndDate EXPIRATION_DATE Expiration Date of denied party

Code AGENCY_CODE Agency Code

LastUpdated ENTRY_DATE Last updated date of denied party
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Content GTM Element Description

Provider

Element

IDNUM ENTRY_ID Unique ID of the denied party from the
content provider

Voll RULING_VOLUME Volume in which the denied party appears
in federal regulations

Pagel RULING_PAGE_NUMBER Page Number on which the denied party
appears in federal regulations

FedDatel FEDERAL_REGULATION_DATE Date on which the denied party was added
to federal regulations

Notes NOTES Additional Information regarding denied
party

url FEDERAL_REGULATION_URL URL link to the federal regulations

Note: CountryCode is preferred to CountryName as it speeds up the restricted party screening
process. Using the 2-digit country code is more helpful.

The Content Provider must send in each alias as an individual record so that they are also screened
against the party records.

Product Classification Data Mapping

HTS (Harmonized Tariff Schedule) Mapping

The product classification data is saved in the GTM_PROD_CLASS_CODE table. The following table
gives the data saved to the GTM_PROD_CLASS_CODE table.

File
Name

Content Provider
Element

GTM Element

Description

_MASTER

mstr_id

GTM_PROD_CLASS_CODE_GID

Unique identifier used by GTM
to create classification code for
a particular version.

Product Classification Code ID
is a concatenation of
Data_Version_ID+'_"+mstr_id.

To identify the classification
code based on the data version.
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File Content Provider GTM Element Description
Name Element

_MASTER | data_type+ GTM_PROD_CLASS_TYPE_GID Product Classification Type is a
iso_country concatenation of data_type +
<space> + (2-
digit)country_code

Eg: data_type is HTS and
country is US. Product
Classification Type would be

‘HTS US'.

_MASTER | hscode CLASSIFICATION_CODE Actual Product Classification
Code

_MASTER | eff_beg_dt EFFECTIVE_DATE The date from which the
classification code is active

_MASTER | eff_end_dt EXPIRATION_DATE Expiration date of the
classification code

_MASTER | section_number SECTION Section number provided by HS

_MASTER | Chapter CHAPTER Chapter number provided by
HS

The description of the product classification code based on the language is saved in the
GTM_PROD_CLASS_CODE_DESC table.

File Name Content Provider | GTM Element Description
Element
_MASTER iso_language GTM_LANGUAGE_GID Language
_MASTER full_desc DESCRIPTION Description up to 3997
characters followed by *..." is
taken

The notes designed to clarify the proper classification of goods is saved in the table
GTM_PROD_CLASS_CODE_NOTES.

File Name Content Provider | GTM Element Description
Element
NOTE_TYPE Value : ‘Notes’
_MASTER notes NOTE_VALUE Notes up to 3997 characters
followed by *..." is taken
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GTM derives the data related to the following attributes from the third party content provider and the
respective attribute value is saved as ATTRIBUTE_VALUE for an ATTRIBUTE_NAME in the

GTM_CLASS_CODE_ATTRIBUTE table.

File Name Content Provider
Element

GTM Element

Description

_ATTRIBUTE attribute

ATTRIBUTE_NAME

Attribute name for the
Classification code

_ATTRIBUTE value

ATTRIBUTE_VALUE

Attribute Value for the
Attribute Name. There can
be multiple values applicable
for same attribute name for
Example, OGA, PGA can
have multiple values.

_ATTRIBUTE description

ATTRIBUTE_DESCRIPTION

Description for the attribute
value applicable.

Following are the attribute names supported for HTS. The following list of attributes is explicitly coded
in the data loader since an early release of GTM. However, to support flexibility in naming conventions
and enable global content updates as regulatory changes occur, content partners are encouraged to

use the more flexible ATTRIBUTE structure enumerated above.

GTM Attribute Name Description

OGA Other Government Agency Indicator

PGA Participating Government Agency Indicator

ADD_FLAG Anti-Dumping Duties Flag

CVD_FLAG Countervailing Duties Flag

SITC Standard International Trade Classification

ENDUSE_CD End Use Classification

ASUSDA_FLAG ASUSDA Flag

NAICS North American Industry Classification System
(NAICS) Classification

HITECH Hi-Tech Flag

QUOTA_INDICATOR

Quota Program Indicator

SHORT_DESCRIPTION

A shortened version of the tariff description often used
for printing on documentation
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GTM Attribute Name

Description

IS_AES_REPORTABLE

Indicator that the HS code can be used for US Export
Declarations (AES Filing). If not populated, a
Schedule-B Code must be submitted instead.

LACEY

Lacey Act Flag

In order to preserve the hierarchy of the product classification codes, the product classification data is
saved in the GTM_PROD_CLASS_CODE_PART table. The following table gives the data saved to the
GTM_PROD_CLASS_CODE_PART table.

File Name

Content GTM Element

Provider
Element

Description

_PART

part_id GTM_PROD_CLASS_CODE_PART_GID | Product Classification Code

Part ID is created by
concatenating the Data
Version ID and part_id with
an underscore *_’".

_PART

part_hscode CLASSIFICATION_CODE_PART

Classification Code

_PART

parent_id PARENT_GID

parent_id is the parent part
ID and its detail must be
present in the same file.

Concatenation of
Dataversion_parent_id is
saved as Parent GID. This is
used to display the
classification code details in
tree format.

ROOT_GID

Chapter for the product
classification code

The description of the product classification code based on the language is saved in the
GTM_PROD_CLASS_CODE_PART_DESC table.

File Name Content Provider | GTM Element Description
Element
_PART iso_language GTM_LANGUAGE_GID Language
_PART part_desc DESCRIPTION Description up to 3997

characters followed by *..." is
taken
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GTM supports download of unit of measure (UOM) details at classification code level for reporting the
quantities of goods being imported or exported. These details are saved in the
GTM_PROD_CLASS_CODE_UOM table. The following table gives the mapping of the UOM details saved
to the GTM_PROD_CLASS_CODE_UOM table.

File Name Content Provider GTM Element Description
Element

_UOM name UOM_NAME Identifies the parameter name
for which the unit of measure
needs to be reported. The value
can be either
REPORTING UOM 1, REPORTING
UOM 2.

_UOM oracle_unit_code UOM_CODE Standard UOM in which the
quantity should be send.

_UOM country_specific_UOM | REPORTING_UOM UOM in which the quantity

should be reported.

Note: Download of Schedule B classification data is modeled as HS type.

ECCN (Dual-Use Export Control Classification Numbers) Mapping

File Content GTM Element Description
Name Provider
Element

_MASTER | mstr_id GTM_PROD_CLASS_CODE_GID | Unique identifier used by GTM to create
classification code for a particular
version.
Product Classification Code ID is a
concatenation of
Data_Version_ID+'_"+mstr_id.
To identify the classification code based
on the data version.

_MASTER | '‘ECCN ' + GTM_PROD_CLASS_TYPE_GID | Product Classification Type is a

iso_country concatenation of data_type + <space>

+ (2-digit)country_code
Eg: For country = US, Product
Classification Type would be ‘ECCN US'.

_MASTER | eccn_no CLASSIFICATION_CODE Actual Product Classification Code

_MASTER | eff_beg_dt EFFECTIVE_DATE The date from which the classification
code is active

_MASTER | eff_end_dt EXPIRATION_DATE Expiration date of the classification
code
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The description of the product classification code based on the language is saved in the
GTM_PROD_CLASS_CODE_DESC table.

File Name Content Provider | GTM Element Description
Element
_MASTER iso_language GTM_LANGUAGE_GID Language
_MASTER eccn_desc DESCRIPTION Description up to 3997

characters followed by *..." is
taken

The notes designed to clarify the proper classification of goods is saved in the table
GTM_PROD_CLASS_CODE_NOTES.

File Name Content Provider | GTM Element Description
Element
_MASTER NOTE_TYPE Value : ‘Notes’
_MASTER notes NOTE_VALUE Notes up to 3997 characters

followed by *..." is taken

GTM derives the data related to the following attributes from the third party content provider and the
respective attribute value is saved as ATTRIBUTE_VALUE for an ATTRIBUTE_NAME in the
GTM_CLASS_CODE_ATTRIBUTE table.

File Name Content Provider GTM Attribute Name | Description
Element

_MASTER unit UNIT Units of Measure

_MASTER at CONTROL-AT Reason for Control: Anti-
Terrorism

_MASTER atl CONTROL-AT1 Reason for Control: Anti-
Terrorism Column 1

_MASTER at2 CONTROL-ATZ2 Reason for Control: Anti-
Terrorism Column 2

_MASTER cb CONTROL-CB Reason for Control: Chemical &
Biological Weapons

_MASTER cbi CONTROL-CB1 Reason for Control: Chemical &
Biological Weapons Column 1

_MASTER cb2 CONTROL-CB2 Reason for Control: Chemical &

Biological Weapons Column 2
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File Name Content Provider GTM Attribute Name Description
Element

_MASTER cb3 CONTROL-CB3 Reason for Control: Chemical &
Biological Weapons Column 3

_MASTER cc CONTROL-CC Reason for Control: Crime
Control

_MASTER ccl CONTROL-CC1 Reason for Control: Crime
Control Column 1

_MASTER cc2 CONTROL-CC2 Reason for Control: Crime
Control Column 2

_MASTER cc3 CONTROL-CC3 Reason for Control: Crime
Control Column 3

_MASTER cwW CONTROL-CW Reason for Control: Chemical
Weapons

_MASTER ei CONTROL-EI Reason for Control: Encryption
Items

_MASTER fcl CONTROL-FC1 Reason for Control: Firearms
Convention Column 1

_MASTER mtl CONTROL-MT1 Reason for Control: Missile
Tech Column 1

_MASTER mt2 CONTROL-MT2 Reason for Control: Missile
Tech Column 2

_MASTER np CONTROL-NP Reason for Control: Nuclear
Nonproliferation

_MASTER npl CONTROL-NP1 Reason for Control: Nuclear
Nonproliferation Column 1

_MASTER np2 CONTROL-NP2 Reason for Control: Nuclear
Nonproliferation Column 2

_MASTER nsl CONTROL-NS1 Reason for Control: National
Security Column 1

_MASTER ns2 CONTROL-NS2 Reason for Control: National
Security Column 2

_MASTER rs CONTROL-RS Reason for Control: Regional
Stability

_MASTER rsi CONTROL-RS1 Reason for Control: Regional
Stability Column 1
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File Name Content Provider GTM Attribute Name Description
Element

_MASTER rs2 CONTROL-RS2 Reason for Control: Regional
Stability Column 2

_MASTER Si CONTROL-SI Reason for Control: Significant
Items

_MASTER sl CONTROL-SL Reason for Control:
Surreptitious Listening

_MASTER Sss CONTROL-SS Reason for Control: Short
Supply

_MASTER un CONTROL-UN Reason for Control: United
Nations Embargo

_MASTER Z CONTROL-Z Generic attribute for items
regulated by other agencies

_MASTER agr EXCEPTION-AGR License Exception: Agricultural
Commodities

_MASTER app EXCEPTION-APP License Exception: Computers

_MASTER apr EXCEPTION-APR License Exception: Additional
Permissive Re-exports

_MASTER avs EXCEPTION-AVS License Exception: Aircraft,
Vessels and Spacecraft

_MASTER bag EXCEPTION-BAG License Exception: Baggage

_MASTER civ EXCEPTION-CIV License Exception: Civil End-
Users

_MASTER enc EXCEPTION-ENC License Exception: Encryption
Commodities, Software and
Technology

_MASTER gbs EXCEPTION-GBS License Exception: Shipments
to Country Group B Countries

_MASTER gft EXCEPTION-GFT License Exception: Gift Parcels
and Humanitarian Donations

_MASTER gov EXCEPTION-GOV License Exception:

Governments, International
Organizations, International
Inspections Under the
Chemical Weapons Convention,
and the International Space
Station

Copyright © 2012, 2018 Oracle and/or its affiliates. All rights reserved. 4-17




File Name Content Provider GTM Attribute Name Description
Element

_MASTER kmi EXCEPTION-KMI License Exception: Key
Management Infrastructure -
Amendments Only

_MASTER Ivs EXCEPTION-LVS License Exception: Shipments
of Limited Value

_MASTER rpl EXCEPTION-RPL License Exception: Servicing
and Replacement of Parts and
Equipment

_MASTER sta EXCEPTION-STA License Exception: Strategic
Trade Authorization

_MASTER tmp EXCEPTION-TMP License Exception: Temporary
Imports, Exports, Reexports,
and Transfers (In-Country)

_MASTER tsr EXCEPTION-TSR License Exception: Technology
and Software Under Restriction

_MASTER tsu EXCEPTION-TSU License Exception: Technology
and Software Unrestricted

In order to preserve the hierarchy of the product classification codes, the product classification data is
saved in the GTM_PROD_CLASS_CODE_PART table. The following table gives the data saved to the
GTM_PROD_CLASS_CODE_PART table.

File Name

Content
Provider
Element

GTM Element

Description

_PART

part_id

GTM_PROD_CLASS_CODE_PART_GID

Product Classification Code
Part ID is created by
concatenating the Data
Version ID and part_id with
an underscore *_’".

_PART

eccn_no

CLASSIFICATION_CODE_PART

Classification Code

_PART

parent_id

PARENT_GID

Concatenation of
Dataversion_parent_id is
saved as Parent GID. This is
used to display the
classification code details in
tree format.

ROOT_GID

Chapter for the product
classification code
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The description of the product classification code based on the language is saved in the
GTM_PROD_CLASS_CODE_PART_DESC table.

File Name Content Provider | GTM Element Description
Element
_PART iso_language GTM_LANGUAGE_GID Language
_PART eccn_desc DESCRIPTION Description up to 3997 characters
followed by *..." is taken

ML (Munitions List) Mapping

File Content Provider GTM Element Description

Name Element

_MASTER | id GTM_PROD_CLASS_CODE_GID | Unique identifier used by GTM to
create classification code for a
particular version.
Product Classification Code ID is
a concatenation of
Data_Version_ID+'_"+ id.
To identify the classification code
based on the data version.

_MASTER | country_cd GTM_PROD_CLASS_TYPE_GID Product Classification Type is a
concatenation of ML + <space>
+ (2-digit) country_code
Eg: For country US, Product
Classification Type would be ‘ML
us’.

_MASTER | ml_code CLASSIFICATION_CODE Actual Product Classification
Code

The description of the product classification code based on the language is saved in the
GTM_PROD_CLASS_CODE_DESC table.

File Name Content Provider | GTM Element Description
Element
_MASTER iso_language GTM_LANGUAGE_GID Language
_MASTER ml_desc DESCRIPTION Description up to 3997 characters

followed by *..." is taken
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GTM derives the data related to the following notes from the third party content provider and the
respective note value is saved as NOTE_VALUE (maximum 4000 characters) for an NOTE_TYPE in the

GTM_PROD_CLASS_CODE_NOTES table.

File Name Content Provider | NOTE_TYPE Description
Element

_MASTER note NOTE Description up to 3997 characters
followed by *..." is taken

_MASTER notel NOTE1 Description up to 3997 characters
followed by *..." is taken

_MASTER note2 NOTE2 Description up to 3997 characters
followed by *..." is taken

_MASTER note3 NOTE3 Description up to 3997 characters
followed by *..." is taken

_MASTER note4 NOTE4 Description up to 3997 characters
followed by *..." is taken

_MASTER note5 NOTES Description up to 3997 characters
followed by *..." is taken

_MASTER note6 NOTE6 Description up to 3997 characters
followed by *..." is taken

GTM derives the data related to the following attributes from the third party content provider and the
respective attribute value is saved as ATTRIBUTE_VALUE for an ATTRIBUTE_NAME in the
GTM_CLASS_CODE_ATTRIBUTE table.

File Name Content Provider GTM Attribute Description
Element Name
_MASTER sme_ind SME INDICATOR Significant Military Equipment

Indicator

In order to preserve the hierarchy of the product classification codes, the product classification data is
saved in the GTM_PROD_CLASS_CODE_PART table. The following table gives the data saved to the
GTM_PROD_CLASS_CODE_PART table.

File Content GTM Element Description
Name Provider
Element

_PART ID GTM_PROD_CLASS_CODE_PART_GID Product Classification Code
Part ID is created by
concatenating the Data
Version ID and part_id with an
underscore *_".
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File Content GTM Element Description
Name Provider
Element

_PART ml_code CLASSIFICATION_CODE_PART Classification Code

_PART parent_id PARENT_GID Concatenation of
Dataversion_parent_id is
saved as Parent GID. This is
used to display the
classification code details in
tree format.

ROOT_GID Chapter for the product

classification code

The description of the product classification code based on the language is saved in the
GTM_PROD_CLASS_CODE_PART_DESC table.

File Name Content Provider | GTM Element Description
Element
_PART iso_language GTM_LANGUAGE_GID Language
_PART ml_desc DESCRIPTION Description up to 3997 characters

followed by *..." is taken
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